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1.1 - Opening the app

Please allow TypeltdMe to control your computer

Go to your Applications folder and double click on Typelt4Me. The

TypeltdMe's accessibility permission T

Securky & Prvacy Q Sex
first time it launches, you will be presented with a window titled R -
“Please allow Typelt4Me to control your computer” (pictured right). el gt orltmatp :

computer”. Contacss
(D) cvendes Typelt4Me.app

Clicking the OK button below will take you to the y
Security & Privacy System Preferences. Once there, o

e o
know what it is, ask the person who helped you set up [ ooosics s usage
Accessibility access needs to be enabled in order for Typelt4Me to pourtdact Thentiekihe cheesboxnest o ypetitie o
expand abbreviations as you type. Click OK to be taken directly to tako effect. Once youve dans tha, Typeltébde wi be SR
the Accessibility pane in System Preferences, then click the sole o expand sporevistons seyou type. ) onkmioos e che. — ¢
padlock and if prompted, enter your administrator password*. oK
Finally, tick the checkbox next to Typelt4Me and log out or I'm not interested in abbreviation expansion. Don't show this again.

restart your Mac for the setting to take effect.

Please note: until you grant Typelt4Me this accessibility permission,
expansion will “not* work when you type your abbreviations with the keyboard.
It will *only* work when you point and click on your abbreviations in the
TypeltdMe menu bar dropdown list.

*If you don’t know your password, this Apple support page may be of some help:



1.2 - Getting acquainted with text expansion

Typelt4dMe is a text expander. Text expansion is essentially on-the-fly substitution of short

typed abbreviations with longer ‘snippets’ of content, which can include lengthy words, phrases,
boilerplate texts or even pictures. Whenever you type a pre-defined shorthand abbreviation of your
choosing, Typelt4Me instantly replaces it with its corresponding snippet.

® ® TypeltdMe
- — o |__
Preferences Print Help Stats

¥ Active set: Examples (25 snippets)

Sets on this Mac: 1 Sets in iCloud: 1
My iCloud snippets
+[- -

Snippets selected: 1

App Abbreviation Snippet Best regards,
,w br Best regards,
, ds Dear Sir, C/?
A eml| me@ettoresoftware.c... /M 28
\ €eso Ettore Software
v hmadd 123a Home Street,
A ht Hello there,
y lfwd I'm looking forward to it
s lor Lorem ipsum dolor sit...
s mynum 1-408-12345678910
+|— v ) Contents:  Rich text/pictures T]

Formal scanned signature
Behaviour in menu:  Show label <) Insert [ Format &)
Version 5.4.1i (96)

Once you've granted the necessary accessibility permission outlined in section
1.1, launching Typelt4Me will bring up the main window (pictured left). This is
where you’ll customise the app to your liking and define your own personal
shorthand. To give you some inspiration, we’ve included a few dummy
abbreviations you can play with while you get to grips with how everything works.
When you type these in any app that accepts text input, they’ll expand to common
greetings, contact details and phrases - ‘snippets’ of text and / or images.

How about trying one of the examples out? With Typelt4Me running, switch to
your text editor of choice and type . As soon as you type a space after it,
this should instantly become: X

*If this doesn’t happen, it’s possible you didn’t grant Typelt4Me the accessibility permission it
requires for keyboard expansion, or you forgot to log out or reboot your Mac after doing so. Check
the troubleshooting section at the end of this user guide.



Still with us? Great. Text expansion is a fantastic time saver. Hopefully,
you’ve enjoyed typing the examples and watching reams of text content
magically materialise in the blink of an eye. If so, you’ll be pleased to learn
the fun doesn’t stop there.

In addition to expanding abbreviations typed on the keyboard, Typelt4Me
offers a handy point-and-click option. If, like us, you occasionally forget
what abbreviation you assigned to a particular snippet, or even if you
simply don’t feel like typing it, you can scroll through the Typelt4Me menu
bar list and click on it, as shown here (right). Doing so will insert the
shippet contents wherever the cursor is currently positioned in the app
you’re using.

All good so far? Congratulations, you’ve installed Typelt4Me on your Mac
and it’s working as intended. Feel free to try out some of the other pre-
defined abbreviations in the Examples set to get a feel for things before we
move on. In the next section of this guide, we’ll look at ways to define your
own abbreviation / snippet pair.

About Typelt4Me \
Help
Check for updates

Add a Snippet... . ‘
Edit Snippet...

Preferences...

Pause
Quit

Active Set >

br — (Formal signature)
ds — (Greeting (M))
eml — (Work email)

eso — (Company name)
"madd — (Home address!

123a Home Street,
Springfield, XY 43210

» (| atin filler text)



1.3 - Defining your first abbreviation / snippet pair

OK, we’ve had a play with the provided examples and explored the delights
of text expansion, so by now you’re probably champing at the bit to start

defining your own shorthand abbreviations. Let’s get down to business.
[ JON TypeltdMe

8 = O Ll

lefemnoes Print Help Stats

¥ Active set: Examples (25 snippets)

Sets on this Mac: 1 Sets in iCloud: 1
My iCloud snippets

First, you'll want to create your own snippets set, i.e. a file that will contain -
a new group of snippets. Do this by clicking the + button below the bottom _. +

ppets selected: 1

left corner of the “Sets on this Mac” pane (pictured right). When prompted, el iEbrevistionMMIEriret Bestregards,
give your new set a name (“My Snippets”, perhaps) and click Done. a [br BestIogaIds; Jo
yn ds Dear Sir, ¢ (74’—‘
N eml me@ettoresoftware.c... 7"4 (‘4/6
\ eso Ettore Software 7
hmadd 123a Home Street,
ht {ello there,
@ Typelt4dMe
Active set: Ex Enter a name for your new set:
My Snippets
Examples

cancel (TN



Once you've saved your newly created snippets set, you’ll see it appear in

the list, underneath the bundled Examples set. You'll notice it’s highlighted,
which means it’'s now the active set - that is, only snippets within this set will

be expanded. Only one set can be active at any one time. You can easily
switch between them by clicking once on the name of the set you want to
activate. You don’t have to use multiple sets, the option is simply there for
anyone who prefers to keep different snippet types in separate groups, for
use in specific contexts.

Looking further down, you’ll see that the list of snippets is now empty save
for one abb / snippet pair. This is a placeholder that is created by default.
Try typing in your favourite word processor or in the body of an email
(or just about anywhere else). As soon as you type a space* after it, the
word (i.e. your abbreviation) will be replaced by the word

*Later in this guide you’ll learn how to change the expansion ‘trigger’ from a space to an
alternate punctuation key if that suits you better. You'll also learn to fine tune your
preferences to specify whether the character that triggered the expansion should be
appended to the end of the expanded snippet or dropped.

1 = O Ll

| Preferences Print Help Stats

v Active set: My Snippets (1 snippets)

Sets on this Mac: 2

Examples

+ —

Snippets selected: 1
App Abbreviation Snippet
, abb snippet



1.3.2 Define a new abbreviation via the main app window

Now that we’ve observed the snappy way Typelt4Me expands abb to snippet,

it’s time for you to redefine both abb and snippet to something more useful.

If your name were Max Wolfeschlegelstein, you might - for example - want to type
mxw and have that expand to Miax Wolfeschlegelstein. Let’s try that, shall we?

A mekiiie 1. First, double click on abb so that it becomes highlighted. This means it’s now editable.

o

Preferences Print Help

App Abbreviation Snippet snippet

¥ Active set: My Snippets (1 snippets)
Sets on this Mac: 2 Sets in iCloud: 1
R SO m abb snippet

Examples
My Snippets

Snippets selected: 1
. snippet
App Abbreviation Snippet

e CO > A

2. Next, you need to overwrite abb by typing mxw in the abbreviation cell.

App Abbreviation Snippet snippet

+T] (e o LIl

Insert Format ©
Version 5.4.1i (96)

Behaviour in menu:  Show snippet




3. Now press the TAB key to move to the adjacent snippet cell.

App Abbreviation Snippet snippet

4. Overwrite by typing in the snippet cell.

App Abbreviation Snippet Max Wolfeschlegelstein

m Max Wolfeschlegelsteir{

5. Press the TAB key once more and you’re all done, your changes will be saved.

That was easy peasy, wasn't it? You've just defined a new abbreviation / snippet pair
without even breaking into a sweat. Now, every time you type in a Mac app in which
you can type, it will expand to . Go ahead and create as many
new abbreviation / snippet pairs as you need. Add new ones or delete existing ones
using the + and - buttons at the bottom of the snippets list.



Of course, the above steps are all well and good for defining short words, phrases

and names, but what about when you want to take things to the next level? No problem.

To define a particularly long snippet and / or include rich text or pictures, type or paste it

into the full snippet content pane to the right of the snippets list, so you can more easily Plain text

see what you’re doing. JUENIE v Rich text/pictures ;

9  Format &)

To add rich text or pictures, just remember to first select that option from the Contents dropdown

. . . Version 5.4.1i (96)
menu (pictured right), then hit the Save button when you’re done.

We’ve shown you one way to define a new abbreviation and you've grasped the nettle
with gusto. But wouldn’t it be great if instead of doing it that way you could select some
existing text, then create a snippet and its abbreviation without having to re-type it?
Good news: you can do exactly that.

Imagine you are browsing in Safari and there’s some text in a web page discussing Steve
Jobs’ myriad successes that you want to add to your collection of snippets. For instance,
you may want to abbreviate “Apple Macintosh” and have it come up whenever you type



Start by highlighting and copying to the clipboard the text you want
to abbreviate - in this case, Apple Macintosh (pictured).

www.bbc.co.uk/t!

...Next, pull down the Typelt4Me menu and click on the
Add a Snippet... option as shown below.

| About TypeltaMe
Help
Check for updates

Add a Snippet...

The Apple Macintosh sold 50,000 units in its four months on sale  Edit Snippet...

at $1,995.

Preferences...
. Pause
| Quit
In the run up to the launch of the Apple Macintosh Steve L :
Jobs demonstrated his mastery for public engagement s >
and building hype. mxw — Max Wolfeschlegelstein

He hired film director Ridley Scott to make Apple’s ‘1984’
advert, and gained huge publicity by pitching Apple as a
rebel outsider taking on the computer giant IBM. He
secured interviews and features in magazines across
America. The launch was masterminded by Jobs, though
Apple CEO John Sculley said “he was driving people
insane” with his perfectionism. He demonstrated the




A window will come up prompting you to add a snippet with as its
abbreviation (pictured right). By default, Typelt4Me uses the first four
letters on the clipboard to suggest the abbreviation, but you are of
course free to change this to something better / more memorable. Click
the Add this Snippet button when you’re done editing. Just remember, if
you want to add pictures, you’ll need to click the Rich text radio button

(as illustrated below).

Abbreviation: Plain text
Appl| © Rich text

Pretty painless, all in all, no? You may want to consult page 78 of the
Reference section to learn how to define a hot key for adding a snippet
this way. It'll save you reaching for the menu bar. Otherwise, you now
know the basics of how to use Typelt4Me. Feel free to get stuck in and
come back to this guide later when you have specific questions or you
want to learn how to craft more advanced snippets.

®

TypeltdMe

Preferences Print Help Stats Register

¥ Act
Sets ol

Exam)
My Sr

4+ —

Snippe'
App

Behaviour in menu: = Show snippet

v Q Contents:  Rich text/pictures <

Add a Snippet

The current active set is “My snippets” (2 snippets)

Abbreviation: © Plain text Applescript
Appl Rich text

Snippet Contents:
Apple Macintosh

Cancel Add this Snippet

~

Insert < Format ¢

<
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2.1 - What is Typeltdme?

Typelt4Me is a text expander. Text expansion is essentially on-the-fly substitution of short typed
abbreviations with longer ‘snippets’ of content, which can include lengthy words, phrases,
boilerplate texts or even pictures. Wherever you type a shorthand abbreviation of your choosing,
Typelt4Me will instantly replace it with a corresponding snippet that you’ve defined.

The very first text expander developed for Mac OS, Typelt4Me is an app designed to accelerate
your typing by rapidly replacing your custom defined abbreviations with longer ‘snippets’ of text
and / or pictures as you go. Once installed and launched, it silently runs in the background to help
you type more quickly and accurately.

Find yourself typing the same things over and over? Build up a set of abbreviations and the full
text / image ‘snippets' that they represent. Typelt4Me will save you time and keystrokes by
automatically expanding them while you continue typing. This works systemwide, in any app in
which you can type.



2.2 - “How might | use TypeltdMe?”

How you use Typelt4Me will depend on who you are and what you often find yourself writing. It's
popular with doctors, transcriptionists, lawyers, customer support teams, coders, journalists, authors
and bloggers.

Things Typelt4Me can help you knock out more quickly include:

+ people’s names, email addresses and other contact details
+ commonly repeated phrases

+ awkwardly lengthy / difficult-to-spell medical terms

+ boilerplate clauses for legal contracts

+  “Have you tried turning it off and on again?” IT support replies

It can be particularly useful for entering repetitive data in a database file or spreadsheet, or for
anyone who finds him or herself frequently typing the same things over and over.

Many people find Typelt4Me useful for speedily inserting the current date and a return address when
composing letters. It’'s handy for email sign-offs, too. For example, you might type just br to get:



As developers, we use Typelt4dme ourselves to type standard phrases when providing email support
for our software. It’s great for programming, t0o. Abbreviations don't have to be shorter than the text
they type. For example, we’ve defined (5 letters long) to 'expand' to a single character (~), which
is often needed in C programs, yet always seems to disappear from the keyboard when it’'s most
needed.

Typelt4Me can save you having to switch keyboards to type in other languages and use special
characters, accents or symbols. For instance, a US keyboard may not have a readily accessible Euro
symbol, so could 'expand' to €. When typing in French, ag could become & (a with an accent
grave). It’'s much easier than typing alt-" + a.

By defining a set of mnemonic abbreviations for most frequently used words, you can type speedily
yet more accurately and with less effort. Typelt4Me will save you keystrokes and potentially alleviate
repetitive strain injury :)

For example, could instantly produce (if you have
defined u=you, r=are, rh= , ab= , th=the and = )



2.3 - An overview of the main Typelt4Me app window

The main app window comprises three core sections. The toolbar is where
you’ll access preferences, print options and help (i.e. this user guide). You can

also bring up statistics detailing approximately how much time Typelt4Me
has saved you since you started using it.

Below the toolbar is a shallow segment where you'll create and manage your
snippet “sets” - files containing your snippets and their corresponding
abbreviations. This is divided into locally stored sets on the left and sets
stored in iCloud on the right (more on this later).

The deeper bottom segment is where you’ll create and edit your snippets. In the
left half is a list of the snippets contained within the set you’re currently using.

Select one and its contents will be displayed as a large editable preview in
the large pane on the right. Beneath these panes are buttons and controls for
adding, removing, editing, labelling and sorting your snippets, as well as an
assortment of menus for controlling their individual behaviours and crafting more
advanced expansion tricks.

0 = O Ll

Preferences Print Help Stats

TypeltdMe

¥ Active set: Examples (25 snippets)

Sets on this Mac: 1 Sets in iCloud: 1

My iCloud snippets

+ - -

Snippets selected: 1

App Abbreviation Snippet Best regards,
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2.4 - How to create your own custom abbreviations

There are two ways to define an abbreviation and its corresponding ‘snippet’. The first involves selecting some
text, then clicking on Add a Snippet... in the Typelt4dMe menu bar or pressing a hotkey you’ve assigned to that
action. The second entails creating your abbreviation / snippet pair from scratch in the main Typelt4Me app
window. We’ll walk you through both methods.

Suppose you often close your emails with the words . It'd be easy to remember the abbreviation
as shorthand for wouldn't it?

To add this entry to your Typelt4Me snippets set:
type out one last time in your email
select the text and either cut or copy it to the clipboard (36-X or 3-C)
click on Add a Snippet... in Typelt4Me's menu - or press a hotkey you’ve assigned to this action in

Preferences.

This will bring up a window in which you'll be prompted to define a custom abbreviation that will represent the
new shippet that you’re about to create.



By default Typelt4Me will initially suggest that you use the first four letters of the text in the clipboard as your
abbreviation. While this will sometimes be apt, in this case we’d prefer the abbreviation to be kr, so just type that
into the abbreviation field instead. Finally, click the “Add this Snippet” button to add it to the current active set.

Preferences

v Act
Sets o

Exam|
My Sr
+ = |

Snippe

App

Print Help Stats

Add a Snippet

TypeltaMe

The current active set is “My snippets” (2 snippets)

Abbreviation:
kr

Snippet Contents:
Kind regards,

Cancel

I
<

Behaviour in menu: = Show snippet

© Plain text Applescript
Rich text

Add this Snippet

<>

Contents:  Plain text

Insert ] Format

<

Version 5.4.1i (96)

...That’s it! From now on, every time you type kr Typelt4Me will instantly
backspace over the abbreviation (kr) and type the full text for you (

).

Please note: if the text you copy to the clipboard is in rich text format (i.e. it
contains font, style and colour information) and you want to preserve the
formatting, you need to click the “Rich text” radio button. Doing so will save
those RTF attributes when you click “Add this Snippet”. If you don't, the
snippet will be saved as plain text by default and lose any font, style and
colour attributes.

In case you are wondering, the Applescript checkbox is for power users
who wish to define snippets that execute actions using Applescript (more
on that later). Clicking the checkbox will insert the special symbol that will
send the contents of the snippet to AppleScript for execution.



Now we’ll look at how to create a kr —> abbreviation / snippet pair from scratch
in the main Typelt4Me app window. Click on Edit Snippet... in the Typelt4dMe menu - or press

a hotkey you’ve assigned to this action in Preferences.

The main Typelt4Me app window will pop up. First, click the + button in the

bottom left corner or type 3-N. A new default will appear in the list

with the cell highlighted ready for editing. Type your new

abbreviation to replace the word . Press TAB to switch to the adjacent
cell. Finally, type then press TAB again.

Voila! Your new abbreviation and snippet have been saved.

2. Type the abbreviation
and snippet in their
respective fields.

1. Click +

App Abbreviation Snippet Kind regards,

(O o T

o0 e Typelt4Me

U= ; JH

Preferences Print Help Stats
v Active set: My Snippets (1 snippets)
Sets on this Mac: 2 Sets in iCloud: 1
Examples My iCloud snippets
My Snippets
+ = +]
Snippets selected: 1
snippet
App Abbreviation Snippet 22
—» m abb snippet _
* +| = = Q Contents:  Plain text
Behaviour in menu:  Show snippet Insert Format ¢
Version 5.4.1i (96)




2.5 - How do | get something typed for me?

Once you’ve defined your own shorthand in Typelt4Me, there are two ways of triggering automatic insertion
of the text or image an abbreviation represents. The first - usually the quickest and most fluid - involves
tickling the keyboard, while the second is a mouse or trackpad affair. This is how it works:

Type your defined abbreviation, (optionally) followed by a trigger such as a space or punctuation. For

example, type scf for , or for . Typing
could produce . That’s pretty much all there is to it.

In case you’re wondering, if we do define re as an abbreviation for Typelt4Me will not
interfere when we type or or ; it looks for the letters re as a separate word, i.e. preceded and

followed by spaces or by punctuation marks of your choice. It’'s worth noting, mind, that when defining
abbreviations, it's best to avoid potential conflicts with existing words or acronyms. If the first name in the
example above were and not Riccardo, rather than choose be as the abbreviation it would be better to
go with something unique like

If you ever do need to type a letter combo that’s been defined as an abbreviation without it expanding
(perhaps "re your letter dated the 12th..."), pressing the shift key at the same time as the space bar will
prevent the space from triggering expansion. So in our example above re wouldn’t become
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If you click on the Typelt4Me icon in your
Mac’s menu bar you’ll see that the resulting
dropdown lists all of the abbreviations in your
current active snippet set. Click on the one
you want and the snippet will be inserted
wherever the cursor is in the app you're
currently using.

This can be useful if, like us, you occasionally
forget what abbreviation you assigned to a
less frequently used snippet. Just scroll
through the list to find it, click to insert it, then
carry on typing.

Once you've defined an abbreviation, as long as Typelt4Me is running in the background it will be available
“on tap” at all times, anywhere text or images can be pasted. It’ll work in your word processor, paint program,
Finder, Contacts, Safari or just about any app you like. Isn’t technological progress grand? Soon we’ll all be
reclining in sun loungers drinking cocktails while the machines do everything for us.



2.6 - What are snippet “sets”? How might | use them?

In Typelt4Me, a snippet “set” is a file that contains a group of Typelt4Me snippets. These sets
are a way for you to organise and keep different groups or types of snippets separate, if you're
so inclined. You can have as few or as many sets as you like. You could use just a single set
containing all of your snippets, or you could switch between several different sets, each suited
to a particular context.

Your available sets are listed at the top of the main Typelt4Me app window, with the currently
active one highlighted. We start you off with an Examples set to give you some inspiration and
provide some sample snippets to play with. You’ll probably want to create your own in which
you’ll save the new snippets you define. Here are a few examples of how you might use sets:

+  Switch between an “Office set” and a “Home set”.
+ Maintain a secondary “Spanish snippets” set for when you’re typing in that language.

+ Keep a separate “Code snippets” set that you only use when you’re programming.



By design, only one set can be active at a time; this is to prevent conflicts in cases where you
might want the same abbreviation to expand to something different depending on which set
you’re using. For instance, you might have a abbreviation that expands to when
your “English snippets” set is active and to when “Spanish snippets” is active.

In the Mac Finder snippet sets appear as files with the extension “.typeit4me”. They’re stored
in a Sets folder in Typelt4Me’s Application Support folder within your User Library. If you have
a snippet set somewhere else on your Mac (e.g. someone emailed you one to use), double-
clicking it will automatically move it to the Sets folder and activate it.

You can quickly and easily switch between
About Typelt4Me sets by clicking on the one you want in the
Help Typelt4Me menu bar (pictured left) or by

R 1122115 - selecting it in the list at the top of the main

Add a Snippet... LY Typelt4Me app window.
Edit Snippet... ’

0
)
Jo
i

Preferences... r

Pause ’
Quit

Active Set L  Examples h

br — (Formal signature)



2.6.1 Create a new snippet set

Let’s take a look at how to create your own snippets set. It’s easy.
All you have to do is click the + button below the bottom left corner
of the ‘Sets on this Mac’ pane (pictured right). When prompted, give
your new set a name (“My Snippets”, perhaps) and click Done.

o0oe TypeltdMe

L S0l

Preferences Print Help Stats
|

v Active set: Ex Enter a name for your new set:
Sets on this Mac:‘ |M sni " ‘
ni s
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 Cancel
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|- Ettore Software
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A bt Hello there,
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Once you've saved your newly created snippets set, you'll see it appear in the list,  XOK )
alongside the bundled Examples set. You'll notice it’s highlighted, which means it’s 0 - o L
now the active set - that is, only snippets within this set will be expanded. —r

Preferences Print Help Stats

v Active set: My Snippets (1 snippets)

. . . . Sets on this Mac: 2
Remember, only one set can be active at any one time, but you can easily switch . |
xamples

between them by clicking once on the name of the set you want to activate. Again,
you don’t have to use multiple sets if you don’t want to, it’s entirely up to you. The
option is simply there for anyone who prefers to keep different snippet types in

separate groups, for use in specific contexts. b

Snippets selected: 1
App Abbreviation Snippet

...It probably hasn’t escaped your attention that there are two panes for sets and 4 |abb shippet

that the one on the right is headed “Sets in iCloud”. If you put snippet sets in this
pane you’ll be able to use the same snippets on multiple Macs as well as iOS
devices running Typelt4Me Touch and keep them all in sync. We’'ll explain this
further in section 2.6.2.



Snippet sets in the “Sets in iCloud” pane will be shared and synced with all Macs that are logged
in to your iCloud account and running Typelt4Me. They’ll also be shared with any iPhones and

iPads logged in to your iCloud account that are running the

. You can use the same snippet(s) on multiple Macs and iDevices and keep those snippets in

sync across all your machines even as you add new ones.

Create new sets in the iCloud sets folder using the + button underneath it or move existing local
sets to it by dragging them across (pictured below). If you want to move a set back out of iCloud
and have it only be available locally, just drag it back to the “Sets on this Mac” pane.

| NON ) Typelt4Me

0 = O Ll

Preferences Print Help Stats

¥ Active set: My iCloud Snippets (1 snippets)

Sets on this Mac: 3 Sets in iCloud: 0
Examples

My iCloud Snippets My iCloud ﬁnippets
My Snippets  +

1. To move a snippet set from the local “Sets on this Mac” pane
over to iCloud, just drag it across as shown here.

[ NN Typelt4Me

0 = O Ll

Preferences Print Help Stats

¥ Active set: My iCloud Snippets (1 snippets)

Sets on this Mac: 2 Sets in iCloud: 1
Examples My iCloud Snippets
My Snippets

2. Your snippet set will now be shared with any other Macs that are
logged in to your iCloud account and running Typelt4Me.


http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewSoftware?id=300973416&mt=8
http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewSoftware?id=300973416&mt=8

2.7 - Where and when does Typelt4Me type?

Technically, the “typing” that Typelt4Me performs when it expands one of your abbreviations is
actually a “paste” operation. It will occur wherever you are currently entering text, be it in a word
processing document, an email message, a save dialog, a folder or file name field, a database
entry field and so on.

A snippet - which can be text and / or picture(s) - will be pasted wherever the cursor is currently
positioned when you do one of the following things:

* you use your mouse or trackpad to “pick” it from a list in Typelt4Me's point-and-click menu

+ you type the abbreviation associated with the snippet (optionally) followed by any of up to 35
potential trigger characters. The default trigger is a space.

If you go to the Triggers tab in Typelt4Me’s preferences, you can define exactly what characters
should act as triggers. You can also choose to have no triggers, in which case your abbreviations
will expand as soon as you type them.

When expanded, snippets that were defined and saved as plain text will match the font and style
of any text immediately preceding the point at which you insert them. “Only “rich text” snippets will
preserve the formatting with which they were originally saved, wherever you expand them.



Typelt4dMe works with the vast majority of third party applications that accept text input. That said,
while it’s rare, conflicts can occasionally arise. The automatic “typing" of your snippets is achieved
by temporarily placing the snippet contents on the Clipboard and issuing a Paste command.
Some apps are built in such a way that they can’t handle pasting in certain text fields and this can
prevent Typelt4Me from doing its job.

If Typelt4Me ever appears to fail, try doing a "manual" paste (cmd-v) into the text field in which
you’re typing and see if that works. If it doesn't, then the developer of the software in question has
built it in such a way that it will prevent Typelt4Me from working. This is the case in Entourage, to
cite one example. You cannot expand an abbreviation in the save dialog that follows Save as PDF
in Entourage’s Print dialog. Meanwhile, the same operation works fine in Apple’s TextEdit and
Mail. If you run into a frustrating issue like this and consider it a deal-breaker, your best bet for
resolving it is to contact the developer of the software you’re using and request that they support
pasting into the field in question, so that it will play well with Typelt4Me.

Some password entry fields are protected against programs trying to "sniff" what you type into
them and this can prevent Typelt4Me from working. For example, entering a Typelt4Me
abbreviation in a password field in Safari will not result in expansion of the snippet. All things
considered, given today’s increasingly risky digital security landscape, this is A Good Thing - we
wouldn’t encourage you to store sensitive passwords as unencrypted, plain text snippets.



It’s far more secure to use Safari’s keychain or a dedicated third party password manager app to
handle your online logins, as these can offer a sophisticated level of protection. However, if you
really want to - perhaps you have a low-risk ‘throwaway’ account you frequently log in to and
you’re not concerned about it potentially being compromised - you can use Typelt4Me to enter
passwords for you.

Entering passwords with Typelt4Me

Just define an abbreviation, e.g. pw, and define the snippet as
using the Insert > Special menu
to insert the TAB, carriage return and Don’t Append Triggers
symbols. On a login page in Safari, typing the abbreviation rop | Abbreviaton | Snippet Username-password%-

and expansion trigger into the username field will submit your m

login details for you.

ppets selectea:

Secure input can prevent Typelt4Me from working

Secure Input is a very useful protective feature built into many apps that kicks in to shield your
passwords and other sensitive data while these are being entered. This is so that they can't be
intercepted and recorded for nefarious purposes and only you will know what you're typing.
Secure Input is very much a good thing, however it is meant to be used sparingly. It can cause
problems if it isn't turned off again once it's done its job.



http://developer.apple.com/library/mac/#technotes/tn2150/_index.html

In some apps, when the Secure Input protection is triggered it erroneously remains enabled even
after you're done entering the sensitive information and / or you switch to a different app.
Typelt4Me and other text expansion apps will then effectively be 'locked out' of keyboard input
and prevented from functioning until Secure Input is turned off.

How to resolve the Secure Input issue and get Typelt4dMe working again

If Secure Input stops Typelt4Me from working you'll need to identify the app that has left Secure
Input enabled and quit that app. Doing so will enable Typelt4Me to resume expanding your
abbreviations as normal again.

It's often a web browser such as Google Chrome or Firefox that leaves Secure Input enabled,
though there are known issues with other apps too, including popular password managers such
as 1Password and Lastpass. If none of those looks to be responsible, it could also be down to
other third party apps like Fluid, Hulu Desktop, iFinance, Quicken Scheduler, Chronories or
Notational Velocity. If you're a command-line tinkerer you might also want to ensure that
Terminal's 'Secure Keyboard Entry' is turned off when you're done entering a password.



2.8 - How do | stop Typelt4dMe from typing stuff for me?

Sometimes you may want to stop Typelt4Me from doing its thing, for one reason or another. Of
course, you could quit Typelt4Me altogether, but you may find it more convenient to leave it
running and just selectively stop it expanding abbreviations. There are a few ways to do this.

The default trigger for expanding an abbreviation is typing a space after it. If ever you want to type
an abbreviation as part of a sentence without Typelt4Me expanding it, all you need to remember
is to hold down the shift key as you type the space after it. Doing so will prevent expansion.

7DAgut;;pm;; e If you want to type continuously for a few minutes

| Check for updates t without any interference by Typelt4Me, you can
e L temporarily pause automatic expansion of typed
Preferecee abbreviations. To do this, select the Pause option

in the Typelt4Me menu. A small " symbol on the

Typelt4Me icon in the menu bar will denote that
the app is in pause mode.



1o + @ 7 Sat5Dec 17:02 & Q =

About TypeltaMe l When you’re ready for Typelt4Me to carry on
Help

Check xieiass expanding your abbreviations as normal, just
Add a Snippet... .

Edit Snippet... select the Resume option.

Preferences...

Quit

If you're after a longer term solution that switches typing expansion off

indefinitely - even across system restarts - you may wish to check the ® Type
“Disable keyboard expansion” box in Typelt4Me’s Preferences. To find o
this, click on Preferences and navigate to the Expansion tab. It’s the first Preferences Print Help Stats

option in the list on the left. Open at Login Show dc

Triggers  Menu [ Expansion "\t

Expansion preferences:
While this box is checked in Preferences, nothing you type will ever
be expanded. However, you'll still be able to use the point-and-click
menu list to insert snippets, should you need them.

Disable keyboard expansion



There may be certain apps in which you never want expansion to
occur. To that end, you can selectively disable Typelt4Me on a per-
app basis.

All you need to do is go to Typelt4dMe’s Preferences, navigate to the
Apps tab and add those apps you’d like to exclude from expansion
to the list of apps that require special behaviour. Just click the +
button at bottom left and select an app to add to the list. You'll see
that the default special behaviour is to not expand snippets, so you
can leave that as it is.

Once you’ve added the app(s) you'd like to exclude just click Done
and from that point on, Typelt4Me won’t expand any of your snippets
when you’re working in that particular application.

If you later change your mind, just return to the Apps tab in
Preferences, click the app in the list to select it, then use the - button
at bottom left to remove it.

Typelt4Me

Preferences Print Help Stats

Open at Login Show dock icon Show in menu bar
Triggers Menu  Expansion  AutoCorrect Lasey HotKeys

Drag or add an application into this list to instruct Typelt4Me to behave differently
in that app. Click and hold the arrows for a pop up menu in which you can specify:
« do not expand

or
« expand using... (then picking a specific snippets file to use with the application)

Application Special Behaviour
@ 1Password 5.app £ do not expand
@ Dictionary.app £ do not expand

@ CQuickTime Player.app ¢ do not expand

Done

Version 5.4.1i (96)




2.9 - How to include pictures and / or styled text in snippets

It’s likely you’ll mainly be using Typelt4Me to expand abbreviations to long words and phrases,
but in addition to text, snippets can include pictures. To have a picture in your snippet, you just
need to change the contents type from Plain text to Rich text/pictures:

Once you’ve done that, you’ll be able to drag & drop
or paste pictures in the most common formats (gif,
ipeg, png, tiff, etc).

Plain text '
ContentsEA IR/ JE UG ]

Note that when you select Rich text/pictures, you can
. also apply formatting attributes to your text, such as
t ﬂ Format font, colour, bolding, italics, underline and so on.

Version 5.4.1i (96)




When Rich text/pictures is selected, you’ll notice that the Format menu will become enabled, as
pictured here. Typelt4Me offers considerable flexibility when it comes to formatting your snippets.
Have a play around with the various options.

Contents:  Rich text/pictures B

Insert
’ Text > Bold 8B
Version S.LOTW‘WS!_h4 Italic £

Underline #U

T ager .

Smaller 8-
Kern >
Ligature | 2
Baseline >

Show Colors {1+ 88C

Copy Style X 3#C
Paste Style AW




2.10 - How to limit an abbreviation to a specific app

Sometimes, you may wish to specify that an abbreviation should only expand in one specific
app. To do this, just click the icon in the “App” column to the left of the abbreviation; this will
open a menu in which you can select the app to which you’d like to confine the abbreviation.

Say for instance we want the abbreviation ds to expand to but only ever in the Apple
Mail app and nowhere else. In order to specify that, we’d do the following:

1. Click the app
icon to the left of

the ds abbreviation = D]



2. Double click on the
Mail app in the popup
dialogue to associate it
with the abbreviation

TypeltdMe

= O Ll

Preferences Print Help Stats
EO DR RN @ &+ [m Applications
Favorites & Font Book.app
g Droob % Game Center.app
OB & GarageBand.app
& iCloud Drive Q) iBooks.app
#; Applications 8 |mage Capture.app
¥ iMovie.app
(=) Desktop (%) iTunes.app
[ Documents T Keynote.app
@ Launchpad.app
O Downloads g IRTAPTT
5} user "> Maps.app

Pictures

ﬂ Music
E Movies
53 Google Drive

Tags
() inspiration

Behaviour in menu:

> Messages.app

E Mission Control.app
| Notes.app

il Numbers.app

*] Pages.app

% Photo Booth.app

& Photos.app

=% Preview.app

@ QuickTime Plaver.app

Show label

<>

Greeting (M)

Insert

) Q Search

th

Application - 42 MB
Created 29 August 2015 at 03:52
Modified 27 October 2015 at 16:36
Last opened 27 October 2015 at 19:36
Version 9.1
Add Tags...

Cancel Open

C Format ¢ Save

Version 5.4.1i (96)




Once you’ve done that, you’ll notice the previously generic app icon (that denotes an
abbreviation will expand in all apps) has been replaced with the Apple Mail icon. This
means the abbreviation will now only expand when typed in that particular app.

To clear an association, just click once on the
app icon to the left of an abbreviation and
confirm your choice when prompted.

Best regarc

Dear Sir,

TypeltaMe

This abbreviation is associated with 'Mail' and will only
expand in that application.
Do you wish to clear the association?




2.11 - Labelling snippets

Snippets can optionally be assigned labels to help you identify them in the
Typelt4Me menu. If you only ever use typed-at-the-keyboard expansion you
may not want to bother with it, but it can be a useful feature if you do find

yourself manually picking snippets from the menu.

For example, you might have two phone numbers: one for personal calls
and the other for office-related matters. Instead of showing up in the menu
as two confusingly similar multi-digit numbers, they could appear as clearly
distinguishable work and personal numbers.

For each snippet, type a memorable
descriptor in the label field (in the bottom
right corner of the main app window,
between the Contents and Insert menus).

Contents:  Plain text [T
Personal iPhone number
Insert Format >

Version 5.4.1i (96)

Two similar phone
numbers with no labels...

iph1— 1-408-45678910123
' iph2 —+ 1-408-12345678910

...Two clearly labelled
phone number snippets

—

0«
About TypeltaMe '

Help
Check for updates

)
0
n

Add a Snippet...
Edit Snippet...

Preferences...

Pause
= Quit
¢
Active Set >

About Typelt4Me |
Help
Check for updates

Add a Snippet...
Edit Snippet...

Preferences...

Pause
Quit

Active Set >

iph1 -+ (Personal iPhone number)
iph2 — (Work iPhone number)



2.12 - Displaying snippets in the Typelt4Me menu

1o + W = FridDec 19550 & Q
About Typelt4dMe

[
123a Home Street,
Springfield, XY 43210

Help
Check for updates

Add a Snippet...
Edit Snippet...

Preferences...

Pause
Quit
Active Set

chx — London Charing Cross

sfdd — Please submit your feedback by...

wbst — www.ettoresoftware.com
Ifwd —» I'm looking forward to it

tsh —+ When this happens, we recommen...

br - (Formal scanned signature)
tam —» that's amazing!

tdd2w — (Today's date + 2 weeks)
tdd — (Today's date)

wkadd — (Work address)

ht — Hello there,

svt — save time

ty —* Thank you

wyt — What are your thoughts?
mynum —* (Work phone number)
thxem — (Thanks for emailing)
eml| — (Work email)

lor -+ (Latin filler text)

eso —* Ettore Software

hmadd ~+ 123a Home Street, Springfield,...

Let’s take a look at the point-and-click menu Typelt4Me offers as an alternative to
expanding abbreviations as they’re typed. By default, this lists all the snippets in the
currently active set, showing both the abbreviations and the labels (if you have
labelled them). You can change this and assign different behaviours to individual
snippets. It’s possible to display none, some or all of your abbreviations in the menu,
setting each one to show just the snippet, just the label, both or nothing at all.

To change the way a snippet is displayed in the Typelt4Me menu, bring up the main
app window and click on it once in the list of snippets to select it, then pick the option
you want from the ‘Behaviour in menu’ pulldown in the bottom left corner.

as vear olr,

123a Home Street,
+|—| =V Q

Use this pulldown to specify how
Behaviour in menu:  Show snippet 4— you want your snippet to be
displayed in the menu.



& e AU 123a Home Street,

(@ |hmadd  |123a Home Street, Springfield, XY 43210
+|—| |=v Q Contents:  Plain text

Hide 81
Show snippet
Show label

Show both 4 R84

'Home address

Behaviour in menu 4 Insert Format

Version 5.4.1i (96)

Selecting a snippet, giving it a
label and picking the ‘Show label’

option from this pulldown...

Please note: while you can control the way individual
snippets are displayed in the menu, this behaviour does
not override the general menu settings in Preferences,
which have priority. If, for example, you specify that an
individual snippet’s behaviour should be to show its label
in the menu, the label will *not* be displayed if in the
general menu Preferences you have selected the “Abbs
only” or “No abbs, no (label), no snippets” options.

...will give you this result in the
point-and-click menu

thxem — (Thanks for enjailing)

eml| — (Work email)

lor — (Latin filler text)
L eso — Ettore Software Y

123a Home Street, =
Springfield, XY 43210 hmadd — (Home adre§§)




2.13 - Sorting and searching abbreviations and snippets

Over time, you may build a substantial library of shorthand abbreviations. It’s not uncommon for
Typelt4Me sets to contain thousands of snippets. This could grow problematic to manage if it
weren’t for...the humble sort button and its stalwart partner the search filter. These two controls
can be invaluable for taming large snippet libraries. Between them, they can help you to zero in
and find specific snippets you may be looking to edit or remove.

Snippets can be sorted using any of the following criteria: Sort button Search filter
Abbreviation (alphabetical or reverse alphabetical order)
Snippet (alphabetical or reverse alphabetical order)
+ — Q
Custom (drag individual snippets into your preferred order) ¥ Sort by abbreviation

Sort by snippet

Date created (newest at the top) Sort by custom

Behaviou
Sort by date created
Date modified (most recently modified at the top) Sort by date modified
Sort by date last used
Date last used (most recently expanded abbreviations at the top) Sort by use frequency
Sort by label

Use frequency (most frequently used snippets at the top)

Label (alphabetical order)



When you select “Sort by abbreviation” or “Sort by snippet”, the relevant column header will
display an upward arrow ( * ) indicating the alphabetical sort order, with symbols at the top,
followed by numbers and finally the letters A through Z. To reverse the sort order, click once on
the column header. The upward arrow will change to a downward arrow to reflect the order.

SNippets selecteaq: |
App Abbreviation ~ Snippet
A br Best regards,
ds Dear Sir,

Looking for a specific snippet? When the snippets list is alphabetically sorted by snippet, typing a
few letters will scroll the list to the first snippet that starts with those letters. When sorted by any
other criteria, the list will scroll to reveal the first abbreviation that starts with the letters you type.



Type one or more letters into the filter field and the list of snippets will shrink to show only snippets
that contain the combination of letters you typed - anywhere in the abbreviation or the snippet
contents. As shown here, with the bundled Examples set active typing the letters into the filter
narrows the list down to three snippet results. The first and last results in the list contain the letters
in their abbreviations (eml and thx

appears because in the contents of the snippet the letters

rFlease seleCl a snippet:

App
A

A

Abbreviation ~ Snippet

br

ds

eml|

eso
hmadd
lor
mynum
rrgbmch
thxem

Q

Best regards,
Dear Sir,

me@ettoresoftware.c...

Ettore Software
123a Home Street,

Lorem ipsum dolor sit...

1-408-12345678910

I've read your report...

-

Thank you very much...

), while the middle result - a latin dummy copy snippet -
are found in the latin word Lor

rFlease seieCl a snippet:

App Abbreviation A~ Snippet

A

A

A

eml me@ettoresoftware.c...
lor Lorem ipsum dolor sit...
thxem Thank you very much...

=v| Quen Q



2.14 - “What does this Insert menu do?”

The insert menu enables you to craft more sophisticated snippets. These might produce fill-in-the-
blanks placeholder ‘prompts’ when expanded or perhaps use arithmetical formulae to expand to
dynamically generated, context-aware snippets. You can do things like automatically insert a date
that’s two weeks from now without having to work out what it will be. You can also embed special
characters, nest snippets or even execute complex Applescripts when you type an abbreviation.

Let’s look at how you might go about inserting the current date. Click on Edit Snippet... in the
Typelt4dMe menu to bring up the main app window and click on the + ("add") button underneath the
list of snippets. A fresh / entry appears at the bottom of the list, with ready to be
typed over by a name of your choosing that you will assign to this new abbreviation.

Type a name for the new abbreviation. For this Snippets selected
example, dil will stand for date in long format. App  Abbreviation  Snippet
We’re going to make that expand to the current s kr Kind regards,

date, e.. | [ o

snippet



When you've typed the name for your abbreviation, press the TAB key twice: the first press to
move to the snippet field, the second to move to the large snippet editing pane to the right of the
shippets list.

Next, delete the word snippet. We’re going to replace it with a special syntax that will represent the
current date in whichever format you like. Click on the Insert popup menu under the pane and select
the desired date format.

Contents: Rich text/pictures 9

v Insert 20/11/15
Friday, November 20, 2015
Fri, Nov 20, 2015
20151120

2015-11-20

November 20, 2015

Nov 20, 2015

151120

15-11-20

Time >
Date / Time Math...

ﬁ Special >
>

Snippets

2015
15

November
Nov

1

"

Friday
Fri
20
20




Once you've selected a date format, you will see a funny looking mix of % signs and letters or
numbers, for example: %A, %B %e, %Y

App Abbreviation Snippet %A, %B %e, %Y

»  kr Kind regards,

This is a standard way to describe the elements making up date and time, called strftime. We won’t
go into detail about it here; there is a wealth of information about strftime on the web, if you're
curious. What’s important is you can use the above Date and Time menus to pick pre-defined formats
or you can roll your own using the individual elements in the lower three sections. You can get very
granular and choose whether to display a leading zero in the month and / or day.

That’s effectively it. No more scratching your head trying to remember what day it is, fumbling for a
calendar or painstakingly typing out the current date. Just rattle off a quick di! (or other abbreviation of
your choice) and Typelt4Me will take care of the rest, spitting out (for
example) in the blink of an eye.



To insert the current time, we follow the same initial steps outlined in section 2.14.1 that covers
inserting the current date. Click on Edit Snippet... in the Typelt4dMe menu to bring up the main app
window and click on the + ("add") button underneath the list of snippets. A fresh / entry
appears at the bottom of the list, with ready to be typed over by a name of your choosing that you
will assign to this new abbreviation.

Type a name for the new abbreviation. For this example, will stand for current time. We’re going
to make that expand to the current time, e.g.

App Abbreviation Snippet snippet
A kr Kind regards,
dtl %A, %B %e, %Y

A
® P

When you've typed the name for your abbreviation, press the TAB key twice: the first press to
move to the field, the second to move to the large snippet editing pane to the right of the
shippets list.



Next, delete the word snippet. We’re going to replace it with a special syntax that will represent

the current time in whichever format you like. Click on the Insert popup menu under the pane and
select the desired time format.

Contents: Plain text

¥ Insert

Date / Time Math... 18:04:22

Special | 2 18

06
Snippets | 2 18

6

04
4

22
22

PM



Once you've selected a time format, you will see a funny looking mix of % signs and letters or
numbers, for example: %H:%M

App Abbreviation Snippet %oH:%M
A kr Kind regards,
y  dtl %A, %B %e, %Y

This is a way of describing the elements making up date and time, called strftime. We won’t go
into detail about it here; there is a wealth of information about strftime on the web, if you're
curious. What'’s important is you can use the Time menu to pick pre-defined formats or you can
roll your own using the individual elements in the lower three sections. You can be very granular
and choose whether to display leading zeroes before single-digit hours or minutes.

That’s pretty much all there is to it. Just rattle off a quick (or other abbreviation of your choice)
and Typelt4Me will take care of the rest, spitting out (for example) in the blink of an eye.



In addition to inserting the current date and time, Typelt4Me offers date and time mathematics. You
can set up formulae that will calculate a past or future date for you in relation to the present and
produce that dynamically upon expansion. For example, you might wish to create a ‘due date’
abbreviation that expands to “Please submit your feedback by [a date exactly 3 months from now]”.

To create that snippet asking people to submit feedback by a due date exactly 3 months away,
start off the usual way, defining an abbreviation ( perhaps) that expands to

. Then, with the cursor placed at the end of that phrase, click the Insert menu
and pick the Date option, selecting the format you'd like.

Contents: Rich text/pictures 7]
I
v Insert » Date » 20/11/15
— Time » Friday, November 20, 2015

Date / Time Math... Fri, Nov 20, 2015

20151120
1 Special > 2015-11-20
| N ber 20, 2015
Snippets > ovember

| Nov 20, 2015
151120
15-11-20

2015
15

November
Nov

n

"

Friday
Fri
20
20




Your snippet should now look something like this:

The string of percentage signs and letters tells Typelt4Me what date format to use when it calculates

and outputs the date during expansion.

Please submit your feedback by %A, %B %e,

%Y

Contents: | Plain text [T
nsert > [ >
Time | 2
Date / Time Math...

'1 Special | 2 r
Snippets >

Now it’s time to concoct a formula. In the Insert menu, pick the Date / Time Math...
option. A window will appear that shows the current date and time. Underneath
that, there will be a number of ‘stepper’ buttons that correspond to days (DD),
months (MM), years (YY), hours (HH) and minutes (MM). These are for specifying
how far in the past or future the dynamically generated date should be.

Click on the upward arrow part of the MM
stepper button three times to add three
months to the current date (the resulting
date in relation to the present will be
displayed above, on the right). When
you’re done, click OK. This will insert a
formula in your snippet that will output a
date exactly three months in the future
every time the snippet is expanded. Click
the Save button and you’re done.

Use the steppers to increase (or decrease) the value
to add to (or subtract from) each time component at
expansion time.

28/ 11/ 2015, 20:13 >>> 28/02/ 2016, 20:14

02 +38°¢ 0|1° 0[S 0||C
DD MM ey HH MM

Remove Date Math

Cancel [ oK



With the date and time mathematical formula added, your snippet will now look something like this:

Snippets selected: 1

App Abbreviation Snippet Please submit your feedback by %A, %B %e,
. %Y@@@7862400.000000
m Please submit your fe...
wbst www.ettoresoftware.c...
In this example, now every time you type the abbreviation Typelt4Me will expand it to

, dynamically calculating the last part
upon expansion to produce a date exactly 3 months hence. So if today is Saturday, December 5,
2015, typing will produce

Now you know how it’s done, you may wish to practice repeating the process and use more of the
stepper buttons to construct more complex formulae and create abbreviations that will expand to
various different dates and times of your choosing.



You can use the Insert > Special menu (pictured right) to embed certain characters in
expanded text (but only when the cursor is blinking in the large right-hand pane, not in the cell
in the Snippet column). These are:

+ aspecial syntax (%l ) to tell Typelt4Me where to position the cursor after
expansion. For example: b could be defined as <b>%I/</b>%- and would
expand to <b></b> with the cursor placed between the html tags, ready
for you to type the text to be tagged as bold in a web page you are
editing.

¥ Insert
Notice the use of %l to move the cursor left between the begin/end html
tags and the use of %- at the end of the expanded text to tell Typelt4Me
“not* to add the trigger after expanding the abbreviation or else it would
come out as <b> </b>, with a space (or whatever your chosen trigger)
just after the <b> tag.

+ a special symbol (<X]) to represent a backspace (e.g. if you define g to
type <backspace=ing you'll be able to stick the ing ending to any
previously typed verb, saving you a keystroke)

* aspecial symbol (=) to represent a TAB that will be typed separately
from the rest of the snippet (very useful to create snippets that fill two or
more tab-separated fields or cells)

» Date
' Time

vy

Date / Time Math...

DETETINCE  Position cursor here

Snippets

>

<& (Type a Backspace)

. - (Type a TAB)

- (Type a TAB left)
<J (Type a Carriage Return)

3 (Paste Clipboard Here)
% (Execute as AppleScript)

$<autocue X

Append Trigger
Don't Append Trigger




a special symbol (<J)) to represent a Carriage Return (also called Enter) that will be typed

separately from the rest of the snippet (very useful to "press" the Send, OK or Login button
when filling in forms)

a special symbol (38) to tell Typelt4Me to insert the current contents of the clipboard at
that position (NB if you ever need to have the 3 symbol actually appear in the expanded
text, insert 2 of them next to each other: 36 36)

a special symbol (%) which will cause Typelt4Me to send the entire text of the snippet to
AppleScript for execution.

Note: if the text is not a valid AppleScript script, expanding the abbreviation will return an
error. It is up to you to ensure the AppleScript is valid, as Typelt4Me performs no checks

a special syntax (%+) to tell Typelt4Me that it *must* append the trigger that caused the
abbreviation to expand. This is useful for overriding the general Preferences setting for the
Append/Don't Append Trigger on an abbreviation by abbreviation basis.

a special syntax (%-) to tell Typelt4dMe *not* to append the trigger that caused the
abbreviation to expand. Again, this is handy if you want to override the general
Preferences setting for the Append/Don't Append Trigger on an abbreviation by
abbreviation basis.



+ aspecial syntax (<autocue ) to tell Typelt4Me to display the text between the scissors
and hourglass as a cue and then wait until you press Tab. We’ll explain Autocue in more

detail later.

Autocue is a great time-saving feature that’s popular with power users. It enables you to set
up templates containing placeholder prompts ("cues") for you to replace with corresponding
text or data when a particular abbreviation is expanded.

Date >
Time >
Date / Time Math...

Special > Position cursor here

Snippets » | <] (Type a Backspace)
| - (Type a TAB)

- (Type a TAB left)
<J (Type a Carriage Return)

3 (Paste Clipboard Here)

% (Execute as AppleScript)

Append Trigger
Don't Append Trigger

To include an autocue within a snippet, position the cursor in the
large snippet content editing pane where you want it to start, then
use the Insert > Special menu to insert an autocue. It will appear

like this: autocue; . Just replace the word autocue with whatever

you would like the prompt to say during expansion and you’re done.



Let’s look at a hypothetical example of how a doctor writing a letter might use Autocue for
quickly entering a patient’s details in a standard format. S/he could have defined an
abbreviation, e.g. , that expands to a snippet spread over several lines, with autocues
inserted to prompt for the patient’s name, date of birth, height and so on.

App Abbreviation Snippet Patient Details:

Patient Details: Name: $<name &

Date of Birth: $¢dd X / $¢mm X / $<yyyy &
Height: 8<height ¥

The abbreviation will expand in stages, with each autocue prompting the doctor and waiting

for input before proceeding to the next line. So when s/he types Typelt4Me will begin by
typing the first line, with the name autocue prompt highlighted ready to be replaced by the

patient’s name:

Patient Details:

Name: name



Our doctor types the patient’s name, then presses TAB to continue. Typelt4Me expands the
next part of the snippet and prompts for the patient’s date of birth in dd/ mm/ yyyy format™. All
the doctor has to do is continue the process, entering details and pressing TAB to progress to
the end, at which point the expansion is complete.

* By default, when creating date Autocue prompts Typelt4Me inserts forward
slashes between the day, month and year. If you prefer dashes, just go into the
snippet editing pane and change the slashes to dashes, then hit the Save button.

Patient Details:

Name: Jon Appleseed
Date of Birth: 22/ 11/ 1984
Height: 6’1"

Weight: weight

So, when you want to use Autocue, just remember that when you type your chosen
abbreviation Typelt4Me will expand the text up to the first hourglass symbol, highlight the
“cue” (the word between the scissors and hourglass symbols) and wait for your input. You'll
type the content to replace it and then press TAB to tell Typelt4Me you’re ready to proceed to
the next part - if there is one. Just repeat as necessary until you’re done.

Note: while Typelt4Me is awaiting your input during an Autocue expansion, you can’t expand
other abbreviations. Don’t panic, though: you can always exit ‘autocue mode’ and cancel the
expansion in progress at any time by pressing the esc key twice.



Using the Snippets submenu, you can embed or “nest” other snippets to appear (expanded of
course) within the expanded text of any given snippet. Just pick it from the list and it will be
inserted wherever you’ve positioned the cursor in the snippet you’re editing.

Contents: Plain text

Date >
T Time >

Date / Time Math...

Special >
chx

sfdd
wbst
Ifwd
tsh

br

tam
tdd2w
tdd
wkadd
ht

svt

ty

wyt
mynum
twimc

BECZTI Thank you very much for your email Where they’re inserted in other snippets, in
eml

. the editing pane nested snippets look like this:
rrgbmch

e “Athxem&

hmadd




tell application "Finder" If you know how to use AppleScript, you can use

opliemtons" of startug dise. e Typelt4Me to execute a script when you type a shortcut.
Just create a new abb / snippet pair and type or paste

your AppleScript code into the snippet editing pane*.

say "opening Mail" using "Zarvox"

end tell
Then pull down the Insert > Special menu and pick
Execute as AppleScript.
Contents:  Plain text E
This will place the special symbol % at the beginning of
rime < the snippet, instructing Typelt4Me to pass your snippet

Date / Time Math...

L along to AppleScript for execution instead of inserting it.

Special | 3 Position cursor here

Snippets | 2 < (Type a Backspace)
| = (Type a TAB)
- (Type a TAB left)
<J (Type a Carriage Return)

# (Paste Clipboard Here)
% (Execute as AppleScript)

$=autocue &

Append Trigger
Don't Append Trigger

snippets seiectead: 1
App Abbreviation Snippet %tell application "Finder"
E. open application file "Mail.app" of folder
» sfdd Please submit your fe...  "Applications” of startup disk
For exampl I ify th in houl n Mail
or example, yo.u c':ou d spec 'yt at typing S Oljl d ope. a . ht Hello there, say "opening Mail" using "Zarvox"
and have the built-in OS X voice Zarvox say "opening Mail": . ds Dear Sir,

end tell

hmadd 1224 Home Streeat

*Note: take care with inverted commas. These must be straight ("), not curly (),
or you will get an error when your Mac attempts to execute the Applescript.



2.15 - Preferences

Many of Typelt4Me’s features can be customised to suit your own personal requirements. You can
tweak them to your heart’s content via the Preferences section. Don’t want spaces to trigger
expansion? Looking to disable it completely in certain apps? This is where you’ll do it.

Along the top of the Preferences section you’ll find three ever-present global app setting controls:
checkboxes with which you can specify whether you want Typelt4Me to launch on login and
whether it should display its app icon in the dock and / or menu bar.

The rest of the app’s preferences are organised under six tabs:
Triggers - Menu - Expansion - AutoCorrect - Apps - HotKeys

Open at Login ¥4 Show dock icon ¥2 Show in menu bar

Menu Expansion AutoCorrect Apps HotKeys



Under the Triggers tab you’ll find a set of checkboxes you can use to choose one, several or even
all of 33 different keyboard characters that will act as triggers and cause your abbreviations to be
expanded as you type. To add or remove a trigger, just tick or untick the checkbox next to it.

Open at Login 4 Show dock icon 4 Show in menu bar

W Menu Expansion  AutoCorrect Apps

Select the delimiters that should trigger the expansion:

! . $ % &
* o - -
? < >
@ [ ] { }
TAB Space  Return  nbs esc

All

HotKeys

None

This picture shows the default setting, which is that typing a TAB or
space will trigger expansion. Use the All or None buttons to quickly
select or deselect all check boxes.

If you select None, abbreviations will expand without the need to
type a trigger. While some users have requested this feature,
should you elect to go with this setting you will need to ensure that
no two abbreviations start with the same letters. Otherwise, the
shorter one will trigger as soon as you type it.

You can choose to have the trigger appended or discarded, either
as a global setting or on an abbreviation by abbreviation basis.



2.15.2 Menu

Click the second tab in Preferences if you want to tweak the Typelt4Me menu. This is
where you specify global settings to apply to the point-and-click list of snippets and control

how snippets should be displayed - if at all. See the next page for more detail.

rin

t Help Stats

Open at Login Show dock icon Show in menu bar
Triggers Expansion  AutoCorrect Apps  HotKeys

In the point-and-click snippet list, show:

" Abbs only

© Abb — (label) and/or start of snippets
( ; (label) and/or start of snippets

" 'No abbs, no (label), no snippets

Sort snippets by:
©Abbs  Exp. Custom

Enable point-and-click for all snippet sets

@ # ‘. 0 = FridDec 1950 & Q
About TypeltdMe

Help
Check for updates

Add a Snippet...
Edit Snippet...

Preferences...

Pause
Quit
Active Set >

chx —» London Charing Cross

sfdd —+ Please submit your feedback by...
wbst — www.ettoresoftware.com

Ifwd — I'm looking forward to it

tsh —+ When this happens, we recommen...
br - (Formal scanned signature)

tam — that's amazing!

tdd2w — (Today's date + 2 weeks)

tdd -+ (Today's date)

wkadd —» (Work address)

ht — Hello there,

svt — save time

ty — Thank you

wyt —» What are your thoughts?

mynum — (Work phone number)

thxem — (Thanks for emailing)

eml — (Work email)

lor = (Latin filler text)

eso — Ettore Software

hmadd -+ 123a Home Street, Springfield,...

'
123a Home Street,
Springfield, XY 43210

Menu preferences determine how your snippets
will be displayed in the Typelt4dMe menu (above)




Abbs only

This will list just your abbreviations,
with no accompanying label or
snippet contents. Hovering over an
abbreviation will always reveal a
tooltip containing the full snippet
contents, however.

Jpen at Login Show dock icon Show in menu ba

Triggers Expansion

In the point-and-click snippet list, show:

AutoCorrect  Apps  HotKeys

(label) and/or start of snippets
This won't display your abbreviations, just

" Abbs only

Abb — (label) and/or start of snippets

This is the default setting. Your abbreviations
are listed with their accompanying labels (if
you labelled them) and the first few
characters of the snippet contents. Exactly
what you see will depend on the snippet’s
individual “Behaviour in menu” setting.

© Abb — (label) and/or start of snippets

" (label) andjor start of snippets

the labels assigned to your snippets (if you
have labelled them) and / or the first few
characters of snippet content will be shown.

" No abbs, no (label), no snippets

Sort snippets by:

©Abbs  Exp. ~ Custom

Sort snippet by

This enables you to sort snippets
alphabetically by the first letter of
their abbreviation or expanded text.
Alternatively, if you’ve dragged your
shippets into a custom order in the
main editing window, enable the
Custom option here to reflect that
order in the menu, too.

Enable point-and-click for all snippet sets

Enable point-and-click for all snippet sets

By default, point-and-click is limited to a list of the
snippets in the current active snippet set. If you
check this box, an extra Snippets menu item will
be added, enabling you to browse *all* snippets in
all sets and insert them by clicking.

No abbs, no (label), no snippets

Select this option if you’d prefer to completely
hide the point-and-click snippet list.

Important note: menu preferences
that you set here may in some cases
override behaviours assigned to
individual snippets in the main editing
window. For instance, when defining a
Snippet you may have set it to show its
label in the menu list - but if in Menu
Preferences you've selected “Abbs
only”, that's what you'll get.



Go to the third preferences tab if you want to tinker with settings that govern how Typelt4Me
behaves when expanding your snippets. There are eleven checkbox options from which to
choose. We'll give you a rundown of what each one does.

Disable keyboard expansion

This is fairly self-explanatory. If you check this box, Typelt4Me will no
longer expand your abbreviations automatically as you type. You’ll only
be able to expand abbreviations using the point-and-click menu list.

Open at Login 4 Show dock icon 4 Show in menu bar

Triggers  Menu [=Genbienly AutoCorrect  Apps  HotKeys

Expansion preferences: Extras:
Don’t append trigger
PP gg Disable keyboard expansion No DOuble CAps
You should check this if you don’t want the character that triggers
. . Don't append trigger Capitalize new sentence
expansion to be added to the end of expanded snippets.
Case sensitive expansion All Punctuation Resets Abb

Don't match Abb Case

. . Strip 's' for plurals
Case sensitive expansion

. i . Lo . 4 Pl d i vailable sounds

If you check this option you will have to type your abbreviations in 2 R RGEEAE Qassé" ’
exactly the same upper and / or lower case format in which they were Don't Restore Clipboard Blow
: . . Bottl
defined or they won’t be expanded. Note that Typelt4Me will still alert Hilite abb to replace F:;ge
you if you attempt to define two identical abbreviations, even if you Funk

type them in a different case. So, if “ty” already exists, Typelt4Me will
intervene to remind you if you later try to define a “TY” abbreviation.



Don’t match Abb Case

By default, if you type an abbreviation starting with a Capital letter
or in ALL CAPS then Typelt4Me will expand the snippet
accordingly, so that it starts with a Capital letter or is typed in ALL
CAPS. If you check it, the “Don’t match Abb Case” option stops that
from happening.

Strip ’s’ for plurals

The “strip ’s’ for plurals” setting enables you to define an
abbreviation only once to cover both singular and plural forms. If
you check this option, typing an abbreviation and adding an s to the
end before triggering it will result in the expanded snippet also
having an s at the end.

Suppose you define as . Without this option, you
would also have to define to produce . Either
that, or you would have to type , then a space to trigger the
expansion to , then a backspace and finally type an
at the end of . Instead, if you choose to strip s for
plurals, you'll be able to type and see it expand to

, without the need to define separately.

Open at Login 4 Show dock icon 4 Show in menu bar

Triggers  Menu [SGERE AutoCorrect  Apps  HotKeys

Expansion preferences: Extras:
Disable keyboard expansion No DOuble CAps
Don't append trigger Capitalize new sentence
Case sensitive expansion All Punctuation Resets Abb
Don't match Abb Case

Strip 's' for plurals

Play sound on expansion Available sounds
Basso
Don't Restore Clipboard Blow
Bottle
Hilite abb to replace Frog
Funk



Play sound on expansion

Select this option if you’'d like to hear a system alert sound every time you trigger an expansion.
When the checkbox is ticked, a list of available sounds will appear for you to choose from. Power
users with lots of abbreviations may be driven crazy by constant beeping, but if you only use text
expansion sparingly and tend to look at the keyboard rather than the screen while typing, it can be

useful for alerting you to typos triggering unintentional expansion, for example.

Don’t restore Clipboard

Very rarely, you may run into an issue which causes Typelt4Me to
misbehave and consistently produce the contents of the clipboard
instead of the snippet corresponding to the abbreviation you typed. It
can happen on older, slower Macs or when many apps are open,
causing event handling to slow down. Selecting the “Don’t restore
Clipboard” option will prevent this and ensure you always get the right
snippet expansion. We don’t recommend using this feature unless you
have to, however, because it does mean every time you expand an
abbreviation you’ll lose anything that was copied to the clipboard.

Hilite abb to replace

Tick this checkbox if when you undo (cmd-z) an expansion you’d prefer
to see the abbreviation you typed come back, highlighted and ready to
be replaced with something else.

Open at Login 4 Show dock icon Show in menu bar

Triggers Menu | Expansion | AutoCorrect  Apps HotKeys

Expansion preferences: Extras:
Disable keyboard expansion No DOuble CAps
Don't append trigger Capitalize new sentence

Case sensitive expansion All Punctuation Resets Abb
Don't match Abb Case

Strip 's' for plurals

Play sound on expansion Available sounds
Basso
Don't Restore Clipboard Blow
Bottle
Hilite abb to replace Frog

Funk



No DOuble CAps

This will prevent you from typing two or more consecutive letters in
uppercase. If you turn this option on, you will have to press the
capslock key to type OK, US, USA, NASA, etc. Backspacing over a
letter that has been turned to lowercase will allow you to re-type it in
uppercase.

Capitalize new sentence.

Turning this on will automatically turn the first letter you type after
pressing return to uppercase. Ditto for letters typed after a . ! or ? but
only when they are followed by a space. Note: when typing the first
letter in a new document, it will not be capitalized because
Typelt4Me can only do so when it “watches” you type punctuation, as
explained. This is not a bug, but a normal feature constraint.

All Punctuation Resets Abb

Tick the “All Punctuation Resets Abb" checkbox if you want to
expand abbreviations even when you type them straight after a
punctuation mark.

Open at Login 4 Show dock icon Show in menu bar
Triggers Menu | Expansion | AutoCorrect  Apps HotKeys
Expansion preferences: Extras:
Disable keyboard expansion No DOuble CAps
Don't append trigger Capitalize new sentence
Case sensitive expansion All Punctuation Resets Abb

Don't match Abb Case

Strip 's' for plurals

Play sound on expansion Available sounds
Basso
Don't Restore Clipboard Blow
Bottle
Hilite abb to replace Frog
Funk

Please note: the three “Extras” options may have undesirable side effects in certain exceptional
circumstances. The bottom line is: if they work for you, turn them on. If you are unhappy with their

behaviour, just turn them off. They're entirely optional.



Typelt4Me is primarily concerned with expanding your custom defined abbreviations to longer
snippets of content. Your abbreviations will of course not be dictionary words themselves, so it
might not be the best idea for the app to second guess everything you ever type. That said, it
does offer two flavours of AutoCorrect functionality, accessible under the fourth preferences tab.

Open at Login 4 Show dock icon

Triggers Menu  Expansion

Correct typos using AutoCorrect Dictionary:

Correct typos with AppleSpell

No audio feedback
© Beep on correcting a typo
Speak the corrected word
Available sounds
Basso
Blow
Bottle
Frog
Funk
Glass
Hero

Correction probability:

Lower Higher

&4 Show in menu bar

Apps HotKeys

TidBITSAutoCorrect [T

Ignored words: 3

riccardo
TypeltdMe
wi-fi

+
Also ignore any words

with 4 or fewer letters or

starting with a capital.

Since these days OS X already does a pretty good job of
spellchecking, both of Typelt4Me’s AutoCorrect options are
switched off by default. You can opt to enable just one or
choose to have both active at the same time; they’re
complementary to each other.

If you type something that’s not a dictionary word and it’s not a
defined abbreviation in your active snippet set, either, that’s
when AutoCorrect kicks in. When both options are enabled,
Typelt4Me will first look up your typo in the TidBITS
AutoCorrect Dictionary (a compendium of commonly misspelt
words). If it doesn’t find it there, it will ask AppleSpell (the built-
in OS X spell checker provided by Apple) to make a suggestion
for correction.



If you place .typeit4me snippet sets in ~/Library/Application Support/Typelt4Me/AutoCorrect/ they
will be listed in the popup menu, allowing you to easily change from one to another. By default,
the menu includes the public domain file made available by TidBITS.

When you tick the Correct typos with AppleSpell checkbox, a number of extra options will appear
in the window: No audio feedback, Beep on correcting a typo and Speak the corrected word.

&4 Correct typos with AppleSpell

© No audio feedback
Beep on correcting a typo
Speak the corrected word

You can use the slider to fine tune how
different the suggested correct word can
be in relation to your typo. Different users
will be better served with different settings
to match the kind of typos they’re prone to
making. We recommend experimenting
until you find the setting that suits you.

We recommend you turn on audio feedback,
preferably by having Typelt4Me speak the
suggested correction. On selecting either Beep... or
Speak..., you will be presented with a choice of
system alerts or system voices.

Correction probability:

Lower Higher



To tell Typelt4Me to leave a specific word alone, add the word to the ignored
words list. To add a word, click the + button and type the word. To remove a

Ignored words: 3 word from the list, select it by clicking on it, then click the - button.

riccardo

Typelt4Me

wi-fi
...You may not want to keep opening up Typelt4Me’s AutoCorrect
preferences every time you need to add a word to ignore. Should that be the
case, you can define a HotKey to use as a shortcut. The next time
Typelt4dMe AutoCorrects a word that should have been left alone, press cmd-

z (undo) and while the word you want Typelt4Me to ignore is highlighted,
press the HotKey; the word will be added to the ignored words list.

+
Also ignore any words

with - 4 or fewer letters or Finally, you can also tell Typelt4Me to ignore words that are shorter than a
minimum length that you specify, or those that you type with a capital letter,

starting with a capital. such as proper nouns and acronyms.

Note that AutoCorrect is probably not suited to everyone. It very much depends on the speed and
style of typing of each individual. If you find it doesn't suit your needs, even after tweaking all the
settings, just turn it off. Also note that for AutoCorrect to work, you must select at least one trigger
(space for example) in the Triggers preferences dialog tab.



AutoCorrect in multiple languages

If you assign a hot key for toggling AutoCorrect on and off and have also enabled more than one
language in Language & Region System Preferences, Typelt4Me will first cycle through the top
three languages in the list when you press the hot key.

Autocorrect On/Off: F5

Language & Region preferences contro
and the formats of dates, times, and ¢

For example, if you set F5 as the AutoCorrect hot key and your list of languages
is like the one pictured here, pressing the hot key will switch from English (U.K.)
to Francais. Pressing it again will switch to Deutsch. One more press on the hot
key will turn AutoCorrect off. The next press on the hot key will bring back British

Preferred languages:

English (U.K.)
English, starting a new cycle. English (L

Fran(;ais

DeUtSCh
Note that when you make changes to the Preferred Languages list in System Italiano
Preferences, you will need to relaunch Typelt4Me for the changes to take effect. Espariol

+

The languages AppleSpell can check are: English, French, Italian, Spanish,
German, Dutch, Swedish and Portuguese.



The Apps preference tab is where you'll find the option to assign special behaviours to Typelt4Me
when you’re typing in specific apps. For each app listed (added by drag and dropping or by using
the + button), you can either assign a specific snippet set to be used or you can tell Typelt4Me not
to expand abbreviations at all while you’re in that app. To remove an app from this list, just select

it and click the - button.

[ ] TypeltdMe

Preferences Print Help Stats

Open at Login Show dock icon Show in menu bar
Triggers Menu  Expansion  AutoCorrect Jiiolobly HotKeys

Drag or add an application into this list to instruct Typelt4Me to behave differently
in that app. Click and hold the arrows for a pop up menu in which you can specify:
« do not expand

or
« expand using... (then picking a specific snippets file to use with the application)

Application Special Behaviour
@ 1Password 5.app ¢ do not expand
@ Dictionary.app £ do not expand

@ QuickTime Player.app ¢ do not expand

Done

Version 5.4.1i (96)

Turn Typelt4Me off in a specific app

Perhaps you never want Typelt4Me to expand your abbreviations when you’re
typing in, say, your password manager app. Just add it to the list using the +
button. Leave the Special Behaviour field on the default setting, “do not expand”.

Associate a snippet set with a particular app

If you'd like Typelt4Me to expand abbreviations from one specific snippet set
when you’re typing in a particular app - i.e. not necessarily the set that’s currently
active - add the app to the list using the + button, click on the popup menu
between the Application and

Special Behaviour columns

and pick “expand using...” — E—

then locate the snippet set [ pp v d:pnot:pand

you wish to associate with e

the app in question.



Rather than constantly move your mouse or trackpad pointer to click on the Typelt4Me menu, you
may wish to use quick keyboard shortcuts to initiate certain Typelt4Me actions. To set these up,
head to the sixth and final preferences tab, HotKeys. Here you can define up to six “hot” keys that
when pressed will invoke the following menu options:

+ Add a snippet

+ Edit snippets

Open at Login &4 Show dock icon
+ Pause/Resume expansion Triggers Menu  Expansion  AutoCorrect
« Add a word to the ignored words list Hor v
Add a snippet: F1

+ Toggle AutoCorrect on/off
Edit snippets:

Pause/Resume:

w4 Show in menu bar

ALl HotKeys

Add Word to Ignore: Click to record shortcut

+ Go to Typelt4dMe’s Preferences

Autocorrect On/Off:

Preferences:

In the example pictured here, the F1 function key has been
selected to invoke the “Add a snippet” action.



2.16 - How to uninstall Typelt4Me

Should you ever wish to completely remove Typelt4Me from your Mac, it’s a relatively
straightforward process. Just follow these steps to banish all traces of it for good:

Quit the app (if it’s running).
Locate the Typelt4Me app icon in your Applications folder and move it to the trash.

Locate the file and move it to the trash.
(This file is located in the Preferences folder in your user library. In OS X Lion and later Apple
hides the user library, but you can reveal it by clicking Go in the Finder menu bar and holding

down the alt key on your keyboard.)
Empty the trash.

This will completely remove Typelt4dMe and your Mac will forget it was ever installed. If you later
change your mind, you can reinstall it for free from the Purchased section of the Mac App Store.



A lot of hard work has gone into ensuring your Typelt4Me experience will be as trouble-free as possible. That
said, every app ever developed has the odd hiccup and Typelt4Me is no exception. If you run into trouble, we
are of course happy to help if we can. First, though, we recommend that you consult this troubleshooting

section before contacting us; it could help resolve your issue more quickly. What follows is a list of common
issues you may encounter, together with potential solutions.

3.1 - Common issues and their solutions

If every time you restart or log in to your Mac you find that Typelt4Me is not running but you’d like
it to launch automatically, there’s a simple solution. Launch Typelt4Me and go to Preferences,
then tick the checkbox at the top that says “Open at Login”. With that option selected, you’ll never
have to launch Typelt4Me manually again.



3.1.2 Typelt4Me is running but not expanding abbreviations

Sometimes, people report that Typelt4dMe was working normally but then inexplicably stopped
expanding abbreviations. There are a number of potential causes. If this happens to you, before
contacting support you may want to try these troubleshooting steps, testing to see if expansion
works again after each step:

1. Go to System Preferences > Security & Privacy > Accessibility
and make sure the checkbox next to Typelt4Me is ticked.

@ Typelt4Me.app
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Restart your Mac

Check that the abbreviation(s) you have defined does not contain any delimiters (space, etc)
that you also defined as triggers

Try turning all delimiters ON (click on All) in the Triggers section of Typelt4Me’s Preferences

o TypeltdMe

= ©O Ll

Preferences Print Help Stats

Open at Login Show dock icon Show in menu bar
Menu  Expansion AutoCorrect Apps  HotKeys

Select the delimiters that should trigger the expansion:
a9 @9 # @s 9% Ba a9 v
- ©®+ ®- & 8 O O
a: 9; @ @< Q9> VI )
Be W1 @) /X1 9) @\ 1}
TAB Space Return @ nbs esc ~ :

Al None

Trigger on period (.) followed by another delimiter

Done

Version 5.4.1i (96)



5. Try turning all delimiters OFF (click on None) in the Triggers section of Preferences, then quit
Typelt4Me, relaunch it and select the TAB and Space delimiters.

oe Typelt4dMe oe TypeltaMe
— Al &
Preferences Print Help Stats Preferences Print Help Stats
Open at Login Show dock icon Show in menu bar Open at Login Show dock icon Show in menu bar
Menu  Expansion AutoCorrect Apps  HotKeys Menu  Expansion AutoCorrect Apps  HotKeys
Select the delimiters that should trigger the expansion: Select the delimiters that should trigger the expansion:
! # $ % & U U ! # $ % & ' "
* + = ’ - - * + - ' - -
3 ? < > ( ) 3 3 ? < > ( )
@ [ 1 { } \ / @ [ ] { } \ /
TAB Space  Return  nbs esc ~ : TAB Space  Return nbs esc ~
Al None All None
Trigger on period (.) followed by another delimiter
Done Done
Version 5.4.1i (96) Version 5.4.1i (96)

6. Restart your Mac again
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7. Go to the Expansion tab of Typelt4Me’s Preferences and make sure that the first checkbox,
“Disable keyboard expansion”, is not selected. It may have been ticked by accident.

o} Typelt4Me

1 = O

Preferences Print Help Stats

Open at Login Show dock icon Show in menu bar
Triggers  Menu m AutoCorrect  Apps  HotKeys

. . Expansion preferences: Extras:
Make sure this option
is NOT selected. q Disable keyboard expansion No DOuble CAps
~ Don't append trigger ~ Capitalize new sentence
Case sensitive expansion All Punctuation Resets Abb
Don't match Abb Case

Strip 's' for plurals
~ Play sound on expansion
Don't Restore Clipboard

Hilite abb to replace

Done

Version 5.4.1i (96)

If you've tried all these steps and Typelt4Me still won’t expand your abbreviations, please email
support@ettoresoftware.com


mailto:support@ettoresoftware.com

If you're not seeing the Typelt4Me icon in your menubar, don’t panic. There are three possible
causes, each with a very simple explanation and fix:

Firstly, Typelt4dMe may not in fact be running, in which case you simply need to relaunch it by
double clicking it in your Applications folder (or clicking it in the dock if you keep it there).

Secondly, you may have specified in Typelt4Me's preferences that the menubar icon should not
be visible. Long-press on Typelt4Me in your dock, then navigate to Preferences and make sure
the ‘Show in menu bar' checkbox at the top is ticked.

The third possibility is that - though it's still running - Typelt4Me's icon is being hidden because
the menubar has become crowded and there are a lot of other items displayed to the right of it.
Menubar overcrowding can come about when your screen is not wide enough to accommodate all
your icons as well as all the menu options for the current application in use. MS Word and other
Office applications have lots of menubar options, so you may find this happens when using them.

Fortunately, there are ways to save space and mitigate this. You could, for example, go into
'System Preferences' > 'Users & Groups' > 'Login Options' and change the fast user switching
menu to display as 'lcon' or 'Short name' instead of 'Full name'. Another space saving trick could
be to change the way the date and time are displayed. If you've tried both of these and there still
isn't enough space for you to see the Typelt4Me icon, you could also quit some other less
frequently used apps that perhaps live in your menubar and then relaunch them so that the
Typelt4Me icon moves further over to the right and will be more likely to remain visible at all times.



If you’re familiar with Macs and OS X in general then hopefully the language used to describe
how Typelt4dMe works won’t sound too much like alien gobbledegook. We’ve tried to keep it as
simple as possible and limit the amount of jargon for you to decipher. The following is a short list
of explanations for terms used in a context that’s quite specific to Typelt4Me.

Text expansion

Text expansion is essentially automatic on-the-fly substitution of
short typed abbreviations with ‘snippets’ of content. Its name
derives from the fact that these snippets are usually longer than
the abbreviations they replace and thus ‘expand’ upon them,
producing lengthy words, phrases, reams of boilerplate text or
even pictures.

Text expander

A text expander is a software application that executes text
expansion, automatically replacing custom defined abbreviations
on the fly with snippets of text and / or pictures.



Snippet (aka clipping)

Snippet refers to the full text and / or picture(s) that Typelt4Me
will automatically insert in your document when any given
abbreviation is expanded. It may also refer to the full contents of
an expansion together with its corresponding abbreviation as a
defined pairing constituting a single unit, e.g. “there are 15
snippets in the set” can mean “there are 15 abbreviation /
snippet pairs in the set”. In earlier versions of Typelt4Me
shippets were referred to as “clippings”, because they are items
of content that are copied to and from the Mac’s clipboard.

Abbreviation (aka shortcut)

This is the text you will type (or pick from a list in the Typelt4Me
menu) in order to have a snippet “expanded” (inserted at the
cursor) in the document or text field in which you’re typing.

Snippet set

In Typelt4Me a snippet set is a file containing a list of
abbreviations and their corresponding snippets. In the Mac
Finder these appear as files with the extension “.typeit4me”.
They’re stored in a Sets folder in Typelt4Me’s Application
Support folder within your User Library, or in iCloud.



Trigger

A trigger is a key on your keyboard that when typed directly after
a Typelt4Me abbreviation will cause it to be expanded. There
are a total of 35 potential trigger keys from which you can
choose. Most of them are punctuation keys and symbols.

Delimiter

A delimiter is a punctuation or symbol character that can be
used as a trigger for expanding typed abbreviations.

Sync / syncing

Sync is short for synchronise / synchronisation. Keeping your
shippet sets in sync across multiple Macs means ensuring that
changes made to an iCloud snippet set on one Mac are
automatically available on all your other Macs that are running
Typelt4Me and are logged in to your iCloud account.



This guide is designed to provide you with a solid understanding of how Typelt4Me works.
Hopefully you're already well on your way to saving time and effort that would otherwise be spent
needlessly grinding away at your keyboard. If there’s anything in this documentation that you find
unclear, please do get in touch to let us know. We're also happy to help if you run into problems
that don’t appear to have been covered here.

Please bear in mind that we are a very small team, so if you contact us during an exceptionally
busy period it may sometimes take a little while for us to reply. It’s always a good idea to first
check the troubleshooting section of this guide (page 81) and the Typelt4Me Frequently Asked
Questions section at the Ettore Software website. 9 times out of 10 any problem you’ve
encountered will be a known issue with a documented solution or workaround.

There’s an extensive online FAQ available at

If you have questions that aren’t covered in the FAQ or you’ve run into a problem and can’t find a
fix anywhere, please send an email to


http://faq.typeit4me.com
mailto:support@ettoresoftware.com

